Answers found here!

A free alternative to Microsoft Office? Google Apps gives you that plus plenty of bonus reasons to switch: collaborate on documents with others at the same time; whip up a Web page stocked with downloadable files; and work on it all from any Web-connected computer. About the only thing Google doesn't offer is a guide like Google Apps: The Missing Manual—the authoritative and reader-friendly way to break free of Office.

The important stuff you need to know

- **Get step-by-step coverage** of Gmail, Google Docs, Google Calendar, and Google Talk.
- **Quickly create** word processing files, spreadsheets, and slideshow presentations.
- **Learn how to share and co-edit files**—including revision histories and instant notifications every time a change gets made.
- **Move your files back and forth** between Google Apps and Microsoft Office.
- **Set up and manage your entire organization’s switch** to Google Apps.
- **Create a wiki**—an editable, collaborative Web site.

Why I started the Missing Manual series.

People learn best when information is engaging, clearly written, and funny. Unfortunately, most computer books read like dry catalogs. That's why I created the Missing Manuals. They're entertaining, unafraid to state when a feature is useless or doesn't work right, and—oh, by the way—written by actual writers. And on every page, we answer the simple question: “What's this feature for?”

David Pogue is a *New York Times* technology columnist, bestselling author, and creator of the Missing Manual series.

Free online edition with purchase of this book. Details on last page.
Google Apps: The Missing Manual

Nancy Conner
Table of Contents

The Missing Credits ................................................................. ix

Introduction .............................................................................. xiii

Part I. Docs: Google's Productivity Suite

1. Getting Started with Google Apps ........................................ 3
   Signing Up for a Google Account ........................................ 3
   You’re All Signed Up—Now What? ...................................... 9
   Managing Your Google Account ........................................ 12
   The Google Toolbar ........................................................... 20

2. Word Processing with Google Docs ..................................... 41
   Before You Start: Browser Requirements ........................... 41
   Welcome to Google Docs: A Quick Tour ............................. 42
   Customize Your Setup with Google Docs Settings .............. 47
   Getting Your Docs into Google .......................................... 51
   Ready, Set, Write: Working with Documents ...................... 56
   Editing Documents Offline ............................................... 79
   Sharing and Collaborating on Documents ......................... 86
   Organizing and FindingDocuments ...................................... 105

3. Working with Docs Spreadsheets ....................................... 115
   Getting Started with Google Docs Spreadsheets ............... 115
   Creating a Spreadsheet .................................................... 116
   Formatting a Spreadsheet ................................................. 126
   Adding and Deleting Rows and Columns ......................... 129
   Working with Multiple Sheets .......................................... 131
   Adjusting Cell Sizes ........................................................ 134
   Timesaving Data Entry Tricks .......................................... 135
   Checking Your Spelling .................................................... 139
Inserting Images 139
Sorting Data 141
Formulas and Functions 145
Labeling Cells and Columns with Range Names 152
Working with Charts 154
Displaying Data with Gadgets 161
Printing a Spreadsheet 163
Deleting a Spreadsheet 166
Sharing and Collaborating on Spreadsheets 166
Turn Back Time: Your Spreadsheet’s Revision History 182

4. Creating Slideshow Presentations ................................. 185
   Getting Started with Google Docs Presentations 185
   Creating a Presentation 186
   Editing a Presentation 192
   Previewing a Presentation 213
   Printing a Presentation 213
   Deleting a Presentation 215
   Sharing and Collaborating on Presentations 216
   Turn Back Time: Your Presentation’s Revision History 224

Part II. Communicating and Scheduling

5. Gmail: Email Google-Style ........................................ 229
   Welcome to Gmail: A Quick Tour 229
   Reading and Filtering Email 234
   Writing and Sending Email 249
   Organizing and Searching Your Email 262
   Dealing with Spam 272
   Contacts: Your Gmail Address Book 273
   Customizing Gmail: Your Settings Options 284

6. Keeping in Touch with Google Talk .............................. 295
   Getting Started with Google Talk 296
   Launching Google Talk Manually 315
   Working with Your Friends List 316
   Sending and Receiving Messages 321
   Transferring Files 326
   Inviting Web Site Visitors to Chat with You 329
   Signing Out of Google Talk 330
   The Google Talk Gadget: Taking Talk with You 331
   Google Talk and Gmail 338
Making Free Voice Calls over the Internet 342

7. Tracking Schedules with Google Calendar .................................................. 349
   Getting Started with Google Calendar 349
   Creating a Calendar 353
   Working with Calendars 375
   Using Google Calendar with Other Calendar Programs 394
   Google Calendar on the Go 400
   Calendar Tricks for Google Apps Users 403

Part III. Creating Web Pages

8. iGoogle: Google Your Way ................................................................. 411
   Creating an iGoogle Page 411
   Customizing iGoogle 414
   Customizing, Sharing, and Creating Gadgets 429
   Organizing iGoogle Pages with Tabs 437
   Making iGoogle Your Home Page 442
   iGoogle and Google Applications 445

9. One-Click Web Design with Page Creator ........................................... 447
   Getting Started with Page Creator 447
   Creating Your First Web Page 450
   Site Manager 452
   Editing and Designing Web Pages 456
   Publishing a Web Page 473
   Creating Multiple Web Sites 477

Part IV. Google Apps for Organizations

10. Putting Google Apps to Work ......................................................... 481
    Signing Up for Google Apps 482
    Signing In and Learning Your Way Around 498
    Customizing Your Domain 507
    Adding Users 526
    Getting Started with Email 533
    Adding Domain Aliases 539
    Getting Support 540

11. Administering Google Apps ............................................................... 545
    Managing Users 545
12. **Bring Your Team Together with Google Sites** .......................... 593
   - Signing In and Creating a Site .......................... 593
   - Adding Content to Your Pages .......................... 599
   - Moving a Page Within the Site .......................... 633
   - Change Notifications: Finding Out What’s New ........ 634
   - Printing a Page ............................................. 635
   - Adjusting a Page’s Settings ............................ 635
   - Deleting a Page .............................................. 636
   - Customizing Your Site .................................... 636
   - Managing Your Sites ....................................... 644

13. **Beefing Up Google Apps** .................................................. 657
   - The Google Solutions Marketplace ..................... 657
   - Google Apps APIs .......................................... 663

**Part V. Appendix**

**Appendix: Keyboard Shortcuts** ............................................ 673

**Index** ................................................................................. 681
About the Author

Nancy Conner writes and edits tech books from her home in upstate New York. She’s also worked as a medievalist, an English teacher, and a corporate trainer. When she’s not writing or messing around with someone else’s prose, she likes to read mysteries, visit local wineries, and listen obsessively to opera. Email: NancyLConner@gmail.com.

About the Creative Team

Dawn Frausto (editor, indexer) is assistant editor for the Missing Manual series. When not working, she rock climbs, beads, and causes trouble. Email: dawn@oreilly.com.

Peter Meyers (editor) is the managing editor of O’Reilly Media’s Missing Manual series. He lives with his wife, daughter, and cats in New York City. Email: meyers@oreilly.com.

Nellie McKesson (production editor) is a graduate of St. John’s College in Santa Fe, New Mexico. She currently lives in Jamaica Plain, Mass., and spends her spare time making t-shirts for her friends to wear (mattsaundersbynellie.etsy.com). Email: nellie@oreilly.com.

Sohaila Abdulali (copy editor) is a freelance writer and editor. She has published a novel, several children’s books, and numerous short stories and articles. She recently finished an ethnography of an aboriginal Indian woman. She lives in New York City with her husband Tom and their small but larger-than-life daughter, Samara. She can be reached through her Web site at www.sohailaink.com (http://www.sohailaink.com).

Tony Ruscoe (technical reviewer) is a Web developer living in Sheffield, England. He started using Google in late 2000 and has been following its progress ever since. He now shares his knowledge with others through his personal Web site (http://ruscoe.net) and Philipp Lenssen’s popular Google Blogoscoped blog and forum (http://blogoscoped.com), where he’s been co-editor since 2006. He also maintains a Web site dedicated to researching his surname (http://ruscoe.name).
Lorin Spaulding (technical reviewer) is a systems administrator at O’Reilly Media. When when not working, he indulges in hiking and amateur astronomy. Email: lorin@oreilly.com.

Acknowledgments

A book is the culmination of many people’s hard work. Thanks to Peter Meyers for his support and excellent suggestions from the earliest stages of writing the outline through the final edit. Special thanks to Dawn Frausto for her excellent and helpful edits, as well as her unfailing good humor. The book is much better for her contributions. I’m also grateful to the book’s technical reviewers, Tony Ruscoe and Lorin Spaulding, for their comments, questions, and pointers throughout the manuscript. Thanks to Nellie McKesson for all her work laying out the book, Rob Romano for spiffing up the figures, and Sohaila Abdulali for her eagle-eyed copy edit.

Thanks also to my daughter Tamsen for discussing how she uses Google Docs and Gmail and helping me test out some things with Google Talk (it’s always fun chatting with you)!

Finally, heartfelt thanks to Steven Holzner for his loving support and patience while I was writing this book. You’re the best, and I’m the luckiest!

The Missing Manual Series

Missing Manuals are witty, superbly written guides to computer products that don’t come with printed manuals (which is just about all of them). Each book features a handcrafted index; cross-references to specific pages (not just chapters); and RepKover, a detached-spine binding that lets the book lie perfectly flat without the assistance of weights or cinder blocks.

Recent and upcoming titles include:

Access 2007: The Missing Manual by Matthew MacDonald
AppleScript: The Missing Manual by Adam Goldstein
AppleWorks 6: The Missing Manual by Jim Elferdink and David Reynolds
CSS: The Missing Manual by David Sawyer McFarland
Creating Web Sites: The Missing Manual by Matthew MacDonald
Dreamweaver 8: The Missing Manual by David Sawyer McFarland
Dreamweaver CS3: The Missing Manual by David Sawyer McFarland
eBay: The Missing Manual by Nancy Conner
Excel 2003: The Missing Manual by Matthew MacDonald
Excel 2007: The Missing Manual by Matthew MacDonald
Facebook: The Missing Manual by E.A. Vander Veer
FileMaker Pro 8: The Missing Manual by Geoff Coffey and Susan Prosser
FileMaker Pro 9: The Missing Manual by Geoff Coffey and Susan Prosser
Flash 8: The Missing Manual by E.A. Vander Veer
GarageBand 2: The Missing Manual by David Pogue
Google Apps: The Missing Manual by Nancy Conner
The Internet: The Missing Manual by David Pogue and J.D. Biersdorfer
iMovie 6 & iDVD: The Missing Manual by David Pogue
iMovie ’08 & iDVD: The Missing Manual by David Pogue
iPhone: The Missing Manual by David Pogue
iPhoto 6: The Missing Manual by David Pogue
iPhoto ’08: The Missing Manual by David Pogue
JavaScript: The Missing Manual by David Sawyer McFarland
PCs: The Missing Manual by Andy Rathbone
Photoshop Elements 6: The Missing Manual by Barbara Brundage
Photoshop Elements 6 for Mac: The Missing Manual by Barbara Brundage
QuickBase: The Missing Manual by Nancy Conner
Quicken 2008: The Missing Manual by Bonnie Biafore
Switching to the Mac: The Missing Manual, Tiger Edition by David Pogue and Adam Goldstein
Switching to the Mac: The Missing Manual, Leopard Edition by David Pogue
Windows Vista: The Missing Manual by David Pogue
Windows Vista for Starters: The Missing Manual by David Pogue
Your Brain: The Missing Manual by Matthew MacDonald
You’ve probably used Google to search the Web—who hasn’t? Google is so ubiquitous that it’s even become a verb (you can look it up in Webster’s), as in, “I googled the girlfriend I dumped in high school; now she’s CEO of SuperMegaCorp.” But Google is way more than a search engine. The full list of services it offers is almost as mind-boggling as the number of lightning-fast searches it conducts each day. The next time you’re on Google’s home page (http://www.google.com), click “more”→“even more” to see the whole smorgasbord: from maps to a checkout service for online retailers to photo albums and YouTube—and that’s just for starters.

The biggest recent news from Google, though, is that it’s putting programs online—the kind you used to have to install on your computer. They include applications for word processing; working with spreadsheets; creating presentations; reading, writing, and storing your email; and scheduling appointments and meetings. Google’s brought communication, productivity, and collaboration tools right to your Web browser.

Last but certainly not least, the vast majority of Google’s programs are free. Yup, you read that right: You can get word processing, spreadsheets, email, chat, a Web-page builder, and more, and it won’t cost you a dime. Sound interesting? Read on to learn more.

NOTE

In this book, the term app (with a lowercase a), means an individual Google product, like Google Calendar or Gmail. “App” is an inescapable bit of geek shorthand for “application”—a word that itself is synonymous with “program.”

Google Apps (with a capital A), on the other hand, refers to a bunch of integrated Google products (including some of the aforementioned apps), all wrapped into a highly customizable package that Google hopes companies will sign up for as an alternative to Microsoft’s Office suite of programs. Chapters 2–9 cover individual apps, while Chapters 10–13 cover the Google Apps packages for organizations.

This is just the short version of the individual apps vs. Google Apps conundrum; page xx tackles this slightly perplexing naming choice in more detail.
Welcome to the World of Web-based Applications

What are Web-based applications? Simply put, they’re programs you access over the Internet. You point your Web browser to the place where the application lives online, and then work with it in the same way you’d work with a program that lives on your computer.

Google’s online offerings mean, for example, that you don’t have to install a word processing program on your computer. Instead, you can fire up your Web browser, point it to http://docs.google.com, sign up for a free account, and start creating your first document in mere seconds. You don’t have to remember to save your work—Google does that for you automatically—so you can focus on the task at hand. Google stores your files on its computers (you get lots of free storage space), so your saved documents are safe even if your computer melts down. And you can work on those documents from pretty much any computer with an Internet connection: at work, at home, a friend’s place, the library, wherever. You can even use Google Docs while you’re offline—when you’re flying, for example—so you don’t have to be connected to the Internet in order to do work (“Editing Documents Offline” on page 79 explains how this works.)

It’s Good to Be Web-based

The most obvious advantage of Google’s Web-based products and services is that they’re free, and who doesn’t like free? But there’s a whole bunch of other reasons for using Web-based programs:

• **Portability.** When a program lives on your computer, you can use the program only on that particular computer. So if you work on your desktop computer in the afternoon and then want to work on your laptop that evening, you have to remember to transfer the files, or you’re out of luck. With Google apps, you don’t install anything on your computer, so you can access your applications—and your data—from any computer that can connect to the Internet.

• **Mobility.** Web-based applications also work with mobile devices, so you can get to your information from your Blackberry, iPhone, or any souped-up cellphone. Once you start using Google Docs (Chapters 2–4), you’re free to roam around the planet without fear of being away from your files.

• **Collaboration.** Only you can access a document that lives on your computer’s hard drive. If you want to share it, you have to email it or print it out. When a document lives on the Web, though, you can share it with lots of people at once. With Google Docs, you can invite coworkers to collaborate on a document with you, and you can all work on the same document, at the same time (see “Collaborating with Others” on page 93 for more on this mind-blowing feature). No more emailing spreadsheets around and getting confused about which version is most current, or waiting for somebody to check a report back into SharePoint so
you can have your turn with it. You’re all free to work on the same word processing document, spreadsheet, or presentation whenever you want.

- **Integration.** Individual Google programs and services can talk to other popular programs. For example, Google Docs lets you import and export Excel and Open-Office Calc spreadsheets. And if your company is thinking of making the switch to Google Apps (see Chapter 10), integration with your existing IT infrastructure is definitely possible (not a no-brainer, to be sure, but well within reach of any firm that has one tech-savvy person—and this book). For example, you can migrate email from your current mail server into Google Apps Email while preserving messages’ date information, read/unread status, and the filing system people have used to organize their messages.

- **Updates and bug fixes.** Do you dread having to download and install program updates and patches because of the havoc they sometimes wreak on your system? Well, say goodbye to that sinking feeling. Since Google applications are on the Web, Google automatically takes care of updates and bug fixes for you.

**NOTE**
Since Google apps are Web-based, Google can easily update and improve them—which it does all the time. That means you don’t have to wait for a new edition to come out to take advantage of new features. It also means that what you see on your computer screen may be different from the images in this book. Google makes so many changes, it’s impossible to keep up!

- **Search.** Not surprisingly, Google’s Web-based services have some of the same searching power as its famous find-anything-on-the-Web engine. That makes it easy for you to search your documents, email, and more. For example, Gmail provides so much storage space (page 229) that you may never have to delete another email—and Gmail search makes it a snap to find any email in that haystack of messages.

- **Central administration.** If you own or manage a domain (the address people use to find your Web site, such as myvastdomain.com or ourcompany.com or statecollege.edu), then you can create a Google Apps account, which, as Chapter 10 explains, brings together all Google’s programs in one place for your organization. Google Apps can be helpful for any collection of workers, no matter how big or small. With a few clicks, a Google Apps administrator can set sharing policies across the whole domain, for example. So you can decide whether to let people in your firm share their documents and calendar info with people outside the domain (that is, the general public).

- **Working online or offline.** In March 2008, Google rolled out a new feature: the ability to work offline in Google Docs. Before that, one of the main complaints about Docs was that you had to be connected to the Internet to use it. You could export files to another application, like Word or Excel, to work on them, but then you’d have to remember to import the files to Docs again. But now you can work
with Docs online or off, without having to export anything. This is great if, say, you travel on business and need to work while you’re on a plane and don’t have an Internet connection. The work you do offline gets uploaded automatically next time you connect to the Internet. That way, any file in Docs is always the most recent one. (You can revert to an older version if you want, but that’s another story—one told on page 102.)

• **Security.** You might be thinking, “Okay, Web applications sound great so far—but what about security?” The idea of switching to Web-based programs makes some people nervous. After all, when you store documents and information on your computer’s hard disk or your company’s servers, at least you know where it is. What happens to files and data you store in Google apps? Your data doesn’t simply sit on some computer at Google’s headquarters. Google operates a grid of servers in many locations around the world. So instead of storing your data in one place, it distributes your information across this grid, making it harder for hackers and other nasty types to get their mitts on your info. Compare that strategy to keeping everything on your own computer: What happens if somebody steals your laptop? Even if the thief can’t crack the password and get your data, you still don’t have access to your files. Same goes if you drop your laptop in the pool.

---

**NOTE**

The practice of using Web-based applications and storing data in a “cloud” of networked servers is called *cloud computing*.

---

Google takes data security very seriously. It has full-time security teams whose job it is to repel malicious beastsies like viruses, worms, and spam. Google’s spam protection, for example, runs rings around some of the other Web-based email services. Google uses a combination of sophisticated filters and user reporting to keep spam out of your inbox. It’s not perfect, but it’s darn good—especially when you consider that spam makes up about 90 percent of all the email whizzing around cyberspace.

Most Google apps also support SSL (secure sockets layer), which encrypts data to keep it secure. You know you’re in a secure mode when the URL in your Web browser’s address bar starts with *https://* instead of the usual *http://* (think of that added “s” as standing for “security”). Whenever you sign into your Google Account (which is how you access all of Google’s offerings—see Chapter 1), you do so through a secure connection—one that starts with *https://*—so no one can eavesdrop on your user name and password.
If you’re worried about the security of the data you transmit from your computer into the Google cloud, you can make sure you connection is secure. Just type https:// in front of the URL of the Google application you’re using. For example, connect to Gmail via https://mail.google.com or to Docs via https://docs.google.com. The tradeoff? Performance is slightly slower when your apps are piped over an SSL connection.

- **Privacy.** Privacy’s another issue related to security. You may have heard that Google scans incoming email, looking for keywords, so it can display ads targeted to the email’s content. Is that a violation of privacy? Read the box on page 233 to decide. If privacy concerns you, take the time to read and understand Google’s privacy policy. The box on page 38 gives the highlights, but you can read the whole thing at http://www.google.com/intl/en/privacypolicy.html.

- **Cost.** When it comes to individual applications, you can’t beat Google’s price: They’re free. Compare that to the cost of any program you install on your computer (which doesn’t have all the benefits of Web-based applications).

  If you’re an IT manager (or you play one at your company) and want to sign up for a Google Apps account, you have these choices (explained in more detail in Chapter 10):

  - **Standard Edition** is free.
  
  - **Premier Edition** costs $50 per year, per user. This edition offers some benefits that Standard Edition doesn’t have, such as email migration and 25 GB of email storage for each user.
  
  - **Education Edition** is also free. It offers many of the benefits of the Premier Edition, but is available only to educational institutions (who have a domain name ending in .edu) and nonprofits with federal 501 (c)(3) status.

For a comparison of the different editions of Google Apps for organizations, see the box on page 484.

**What You Get with Google Apps**

So what is Google Apps? A lot of people use the term loosely, meaning just about any Web-based program Google offers. But, technically speaking, they’re wrong. Google Apps (see Figure 1) is actually a specific collection of Google products and services that the company offers to other organizations. Here’s a breakdown of what you get if you sign up for Google Apps:

- **Google Docs (Chapters 2–4).** Create, edit, and share documents online—and work on them when you’re offline, too. Docs lets you create and work with word
processor documents, spreadsheets, and slideshow-style presentations. You can do so much with Docs that this book devotes three chapters to it: one for each kind of document.

**NOTE**

As the Note on page xiii explains, this book uses the term *apps* to describe these individual Google services, which are available to anyone, even those whose firms haven’t signed up for Google Apps.

- **Gmail (a.k.a. Google Apps Email—Chapter 5).** Google’s Web-based email program offers oodles of storage space, labels to keep your messages organized, and the ability to search and filter your email.

- **Google Talk (Chapter 6).** Talk is Google’s instant-messaging service. You can chat with friends and colleagues, see who’s online, and invite the whole gang to a chat as a group.

- **Google Calendar (Chapter 7).** Keep yourself on schedule with this event-management application. You can create multiple calendars, schedule events (you can invite others to join you), and share your calendars with friends and family, colleagues—or the whole world.

- **Page Creator (Chapter 9).** Design your own Web pages and post them online—for free—with Page Creator, Google’s Web page editor.
• **Control Panel (Chapter 10).** The Control Panel is where Google Apps administrators customize all the programs their firms use, and manage individual employee accounts.

• **Start Page (Chapter 11).** Google Apps administrators can design a custom home page for everyone in their organizations with Start Page. For example, you can put your company’s logo at the top, include announcements, and insert gadgets (mini-applications you can embed on a Web page) to give users one-click access to their Google apps. Various gadgets let folks keep an eye on their Gmail inboxes, access collections of important documents, check appointments, and chat with coworkers. And people can customize their own Start Pages to suit their working styles.

  **NOTE**
  Start Page is similar to iGoogle (Chapter 8), Google’s customizable search page that’s available to the general public (page 515 lays out the differences between iGoogle and Start Page).

• **Google Sites (Chapter 12).** Google Sites lets you create a collaborative Web site that a bunch of people can work on—add content to, edit, and so on—at the same time.

  **NOTE**
  Unlike the other apps in this list, which have versions anyone can sign up for (no need for a Google Apps account), Google Sites is available only through a Google Apps account.

---

**More Google Stuff**

*Doesn’t Google offer other applications and services, too? What are they?*

Google offers a ton of products and services, from Alerts to YouTube to Blogger to Web Accelerator. To see them all, go to www.google.com (http://www.google.com) and click “more” → “even more”. Some of these services, like searching, you can just go ahead and use without logging into anything; others require a Google Account (Chapter 1 tells you all about that).

Here’s a list of some popular and useful Google services (none of which are covered in this book, in the interest of keeping this volume under 5,000 pages):

• **Blogger** (http://www.blogger.com). Keep an online journal or sound off on politics, entertainment, or social issues. A blog (short for Web log) is a Web page that contains regularly updated posts about whatever’s on the blogger’s mind.

• **Google Earth** (http://earth.google.com). Google Earth is a virtual globe that uses satellite images and maps to give you a bird’s-eye view of the world in 3-D.
• **Google Groups** ([http://groups.google.com](http://groups.google.com)). On this site, you can read, create, and participate in online discussion groups. (You’ll find Google Groups dedicated to discussing all the Google apps.)

• **Orkut** ([http://www.orkut.com](http://www.orkut.com)). This social networking site is Google’s answer to MySpace and Facebook. Mainly unheard of in America, it’s wildly popular in Brazil.

• **Google Reader** ([http://www.google.com/reader](http://www.google.com/reader)). Google reader helps you stay up-to-the-minute with your favorite blogs and news sites, bringing them all together on a single page.

• **Picasa** ([http://picasa.google.com](http://picasa.google.com)). Store, organize, and share digital photos on the Web with Picasa. Many Google apps let you easily insert a picture—or even a slideshow—from Picasa.

• **SketchUp** ([http://sketchup.google.com](http://sketchup.google.com)). SketchUp lets you create 3-D models, and then put them in Google Earth.

• **Google Notebook** ([http://www.google.com/notebook](http://www.google.com/notebook)). With Google Notebook, you can save, organize, and share clips—snippets of interesting Web sites—in an online notebook as you surf the Web.

• **YouTube** ([http://www.youtube.com](http://www.youtube.com)). This is the Web’s most popular place to post, watch, organize, and discuss video clips. You can embed YouTube videos in Google Sites (page 613).

Want to see what Google’s working on for the future? Check out Google Labs at [http://labs.google.com](http://labs.google.com), Google’s “technology playground.” It’s a place to get a glimpse at up-and-coming Google products and services that aren’t quite fully cooked.

---

**NOTE**

A lot of the products Google offers, including many of the applications covered in this book, have the word “beta” next to their logos. Normally, programs still in the beta (testing) stage aren’t released to the public. But Google has a different philosophy: They like to release programs they’re still working on, so people can try them out and suggest improvements. Google is still actively changing many of the applications described here, so don’t be surprised if a program looks and acts a bit differently than what you read in this book.

---

**Individual Applications Versus a Google Apps Account**

The hardest thing you ever face about Google Apps could be the decision of what to sign up for. Should you just use several of the individual applications or the whole shebang of a Google Apps account? The following scenarios may help you decide:

• **You don’t own a domain name—www.MyGreatCompany.com or www.SavingTheWorld.org—and you don’t want one.** You need to be a moderately tech savvy individual who owns or manages a domain name (and its collection of related
Web addresses) to create a Google Apps account. Sign up for some individual apps if you don’t fall into this category.

- **Your boss told you you’re switching to Google Apps.** If you got a memo saying everyone will be using Gmail, Google Docs, and Google Calendar from now on, then your organization has probably already set up a Google Apps account for you, so you don’t have to choose. All you have to do is sign in and start using the individual applications. (Read Chapters 2–9 so you can beat everyone else out of the starting gate.)

- **You want to use a Google application (or two or three) for personal stuff.** If you just want to use Google’s services for personal stuff, you don’t need the centralized domain administration you get with Google Apps. Simply pick and choose the applications you want, and sign up for them individually. (Start by creating a free Google Account—Chapter 1 tells you how.)

  **NOTE**
  
  If your company uses Google Apps, you can still create your own Google Account with a unique user name and password. That way, you can use your company’s Google Apps account for work, and your personal Google Account for fun.

- **You want to use Web-based applications for your business.** Google Apps offers businesses a boatload of benefits: a network without the costs of setting it up and maintaining it, centralized management of all your applications, shared contact lists, and, of course, the applications themselves. Icing on the cake is that all these offerings get listed at a custom Web address reflecting your organization’s domain name, such as sites.yourcompany.com for Google Sites or mail.yourcollege.edu for student and staff email.

- **You want to create a Web site for a group.** Say you want to create a Web site for your neighborhood association. With a Google Apps account, not only can you create a Web site, you can also give email accounts to key organizers, and let everyone create and share documents related to the group’s business—from monthly meeting agendas to the annual block party. Sign up for Google Apps Standard Edition (page 484), and you get all that (and more) for free—you just pay for registering a domain name (page 491), which costs you about 10 bucks a year.

- **You’re a student with an email address ending in .edu.** Sign up for Google Apps Team Edition (for free), and you can collaborate with others your school. The box on page 497 tells you all about Team Edition.

---

**Google Apps and Your Business**

With Google Apps, your company can spend less time and less money managing IT services. Google takes care of all the hassles of handling email, worrying about security, and holding spam at bay. Google’s own 10,000-plus employees rely on Google Apps
to keep their business running. And if it’s good enough for Google, it might be good enough for your firm, too.

Google Apps comes in two main flavors: the Standard Edition and the Premier Edition. Both offer the same set of applications for your users. The box on page 484 breaks down the nitty-gritty differences between these two editions, but here’s what it boils down to:

- **Standard Edition.** This edition of Google Apps is free. You get all the apps, 6 GB of storage per person, a control center for administrators, work-anywhere mobility, and the great collaboration tools that make Google Apps so impressive.

- **Premier Edition.** This edition of Google Apps costs $50 per user per year. When you think of what your organization can save in time, licensing fees, hardware and software maintenance and upgrades, it’s a great deal. Premier Edition offers all the goodies that come with Standard Edition, plus some extras. Here are the highlights: 25 GB of email storage per person, email migration from your current system, free phone support, APIs to integrate Google Apps with your current system (including single sign-on and user provisioning), email policy management and message recovery. (See Chapter 12 for the lowdown on all that geekery.)

Not sure? You can try out Premier Edition with a 30-day free trial. If you decide it’s not what you need, switch over to Standard Edition before the 30 days are up.

**What You Need to Get Started**

Getting started is easy. Google has designed its applications to be both accessible and easy to use. It takes only a few seconds to sign up and start using your first program. You just need a Web browser (the more recent, the better) and an Internet connection. (Different apps have different browser requirements, so those get covered in the relevant chapters.) Read on to learn the basics you need to set things up.

**For Individual Apps: A Google Account**

If you’re going to sign up for a few individual applications—or even a whole bunch—you need a Google Account. Some applications create a Google Account for you as part of the sign-up process, but it’s a good idea to start by signing up for a Google Account, because it gives you access to all the apps. Point your Web browser to www.google.com/accounts (http://www.google.com/accounts), and then turn to Chapter 1 to sign up.

**For Google Apps for Your Organization: A Google Apps Account**

If you’re a domain administrator (that is, you manage the domain name your organization owns) and you want to use Google Apps for your organization, first you have to
create a Google Apps account for your domain (see Chapter 10). From there, you can create accounts for your users, and customize your domain’s apps the way you want them, as explained in Chapter 11 and Chapter 13.

**Browser Requirements**

To sign up for a Google Account, your browser has to meet these minimum requirements:

- Internet Explorer 5.5 or higher for Windows
- Netscape 7.1 or higher for Windows, Mac, or Linux
- Mozilla 1.4 or higher for Windows, Mac, or Linux
- Firefox 0.8 or higher for Windows, Mac, or Linux
- Safari 1.2.1 or higher for Mac

Each Google app has its own browser requirements, so some of the browsers in this list may not work with a particular application. Check the chapter devoted to the app you want to use for more detailed browser requirements.

---

**TIP**

To find out which version of a Web browser you’re using, open your browser and, on its menu bar, click Help→About. (Except for Safari, where you need to click Safari→About Safari.)

---

If you’ve got the right browser, you’re nine-tenths of the way there. Just a few other things to check:

- **Make sure you’ve got JavaScript turned on in your browser.** *JavaScript* lets your browser run programming code that makes Web pages more interactive. (If you’re not sure whether your browser has JavaScript turned on—most of them do—see the box on page xxiv.)

- **Make sure that your Web browser accepts cookies.** We’re not talking chocolate chip or oatmeal here. *Cookies* are small text files that Web sites download onto your computer; they help customize your visits to the sites. (The box on page xxiv tells you how to set your browser to accept cookies.)

---

**NOTE**

If you’re a Mac fan, Google apps work best if you use Mozilla/Firefox as your Web browser. Not all apps work with Safari or the Mac version of Internet Explorer.
When Java(Script) and Cookies Don’t Mean a Coffee Break

To use Google apps, you need to have both JavaScript and cookies (page xxiii) enabled in your Web browser. Your browser probably came with both activated, but it doesn’t hurt to double-check.

To flick on JavaScript in Internet Explorer version 5.5 or higher, follow these steps:

1. Select Tools→Internet Options.
   The Internet Options box opens.
2. Click the Security tab. In the “Security level for this zone” section, click the Custom Level button.
   A Security Settings box opens. This box has a long list of options.
3. Scroll down the list to the Scripting section. Under “Active scripting”, make sure that Enable is turned on. If it’s not, turn it on. Click OK.
   If you changed “Active scripting” from Disable or Prompt to Enable, Internet Explorer asks if you really want to change its security settings. (If you didn’t make any changes, you don’t see this confirmation box.)
4. Click Yes.
   IE takes you back to the Internet Options box. Click OK to close the box, and then return to what you were doing. Now you’ve got JavaScript working for you.

For browsers based on Mozilla (these include Firefox 1.6+ and Netscape 7.1+), you enable or disable JavaScript starting with Edit on the menu bar:

1. Select Edit→Preferences.
   The Preferences box opens.
2. In the left-hand Category menu, next to Advanced, click the + sign, and then click Scripts & Plug-ins.
   The Scripts & Plug-ins pane appears.
3. Under “Enable JavaScript for”, make sure that the checkbox next to Navigator is turned on. If it isn’t, click the box to insert a checkmark, and then click OK.
   Congratulations—you’ve enabled JavaScript.

Now for the cookies. Internet Explorer 5 handles these a little differently from IE 6. If you’re working with IE 5.5, follow steps 1 and 2 above for opening the Internet Explorer Security Settings box. In the Security Settings list (step 3), scroll down to Cookies. For “Allow cookies that are stored on your computer,” make sure Enable is turned on. Then continue with step 4.

For IE 6 or later, here’s how to turn on cookies:

1. Select Tools→Internet Options.
   The Internet Options box appears.
2. Click the Privacy tab. In the middle of the box, you see a slider that corresponds to your browser’s cookie settings. Make sure that the slider’s at Medium; if it’s
not, move the slider to the Medium setting. (This setting lets your computer accept cookies from Google apps while protecting it from third-party cookies, which marketers often use to collect information about your Web-surfing habits. Third-party cookies arrive at your computer from some Web site other than the one you’re viewing.) Click OK.

IE saves your settings, and then returns you to the Web page you were looking at. In Mozilla/Firefox, you manage cookies using the aptly named Cookie Manager. And you do so in one easy step: Surf on over to the app you want. In Mozilla, select Tools→Cookie Manager→“Allow Cookies from this Site”.

Last but not least: Safari. Go to Safari→Preferences, and then click the Security tab. Turn on the checkbox next to “Enable JavaScript” and, in the “Accept cookies” section, select the radio button next to “Only from sites you navigate to”. That’s it. Easy, huh?

About this Book

This book is designed for both the people who use Google’s applications and the administrators who manage a Google Apps account. So the first nine chapters tell you how to set up a personal Google Account (Chapter 1) and get the most out of each app:

- Google Docs:
  — Word processing (Chapter 2)
  — Spreadsheets (Chapter 3)
  — Presentations (Chapter 4)
- Gmail (Chapter 5)
- Google Talk (Chapter 6)
- Google Calendar (Chapter 7)
- iGoogle (Chapter 8)
- Page Creator (Chapter 9)

Whether you’re using these applications for personal projects or through an organization’s Google Apps account, you can dip in anywhere and get up to speed fast. Each chapter offers tips and tricks to get you working in no time.

Chapter 10 through Chapter 12 are all about Google Apps accounts: how to get signed up and set up (Chapter 10), and how to do the day-to-day administrative tasks that go with managing a domain (Chapter 11).

Google Sites, a relatively new addition to Google Apps, is available only through Google Apps accounts, so that’s covered in the later part of the book (Chapter 12), as well. Whether you’re an admin or a regular user, Chapter 12 tells you how to create, build, and share a site with others in your organization.
Chapter 13 talks about stuff you can add to Google Apps to customize it and make it do more. Whether you’re a business looking to tailor Google Apps to your organization or a just-for-fun user who wants to write a cool new gadget (page 417), this chapter gives you the info you need to get started.

Finally, an appendix lists keyboard shortcuts that can help you work with Google apps faster and more efficiently.

The Very Basics

You’ll find very little jargon or nerd terminology in this book. You will, however, run across a few terms and concepts that you’ll encounter frequently in your computing life:

- **Clicking.** This book gives you three kinds of instructions that require you to use your computer’s mouse or trackpad. To *click* means to point the arrow cursor at something on the screen and then—without moving the cursor at all—to press and release the clicker button on the left side of the mouse (or laptop trackpad). To *right-click* means to point the cursor and click the button on the right side of the mouse (or trackpad); Mac users with only one mouse button can replicate this maneuver by hitting the Control key while they’re clicking. And to *drag* means to move the cursor while pressing the button continuously.

- **Menus.** The *menus* are the words at the top of your browser: File, Edit, and so on. You also find menus within some of the Google applications—they typically appear near the top of your screen. Click one to make a list of commands appear, as though they’re written on a window shade you’ve just pulled down.

  Some people click and release the mouse button to open a menu, and then, after reading the menu command choices, click again on the one they want. Other people like to hold down the mouse button continuously after the initial click on the menu title, drag down the list to the desired command, and only then release the mouse button. Either method works fine.

- **Keyboard shortcuts.** Every time you take your hand off the keyboard to move the mouse, you lose time and potentially disrupt your workflow. That’s why many experienced computer fans use *keystroke combinations* instead of menu commands whenever possible. Ctrl+B (⌘-B on a Mac), for example, is a keyboard shortcut for boldface type in most word processing programs.

  When you see a shortcut like Ctrl+Shift (⌘-Shift) (which lets you select a range of options from a list), it’s telling you to hold down the Ctrl or ⌘ key, and, while it’s down, press the Shift key, and then release both keys.

About→These→Arrows

Throughout this book, and throughout the Missing Manual series, you’ll find sentences like this one: “Select File→Export→.csv.” That’s shorthand for a much longer
instruction that directs you to open three nested commands in sequence, like this: “In
your browser, you’ll find a menu item called File. Click that. On the File menu is an
option called Export; click it to open it. On that menu is yet another option called
*.csv*. Click it to open that, too.” This kind of arrow shorthand helps to simplify the
business of choosing commands in menus, as shown in Figure 2.

Figure 2. In this book, arrow notations help to simplify folder and menu instructions. For example, “Select File→Export→*.csv” is a more compact way of explaining the actions shown here than saying, “From the File menu, select Export. From the submenu that appears, choose *.csv*.”

**About MissingManuals.com**

At the Missing Manuals Web site, you’ll find articles, tips, and updates to this book. In fact, you’re invited and encouraged to submit such corrections and updates yourself. In an effort to keep the book as up-to-date and accurate as possible, each time we publish new editions of this book, we’ll make any confirmed corrections you’ve suggested. We’ll also note such changes on the Web site. (Click the book’s name, and then click the Errata link, to see the changes.)

In the meantime, we’d love to hear your own suggestions for new books in the Missing Manual line. There’s a place for that on the Web site, too, as well as a place to sign up for free email notification of new titles in the series.
While you’re online, you can also register this book at www.oreilly.com (http://www.oreilly.com) (you can jump directly to the registration page by going here: http://tinyurl.com/yo82k3). Registering means we can send you updates about this book, including any additions or Web-only offerings.

**Safari-Enabled**

When you see a Safari®-enabled icon on the cover of your favorite technology book, that means the book is available online through the O’Reilly Network Safari Bookshelf. Safari offers a solution that’s better than e-Books. It’s a virtual library that lets you easily search thousands of top tech books, cut and paste code samples, download chapters, and find quick answers when you need the most accurate, current information. Try it free at http://safari.oreilly.com.
PART I

Docs: Google's Productivity Suite

• Chapter 1, Getting Started with Google Apps
• Chapter 2, Word Processing with Google Docs
• Chapter 3, Working with Docs Spreadsheets
• Chapter 4, Creating Slideshow Presentations
A Google Account is your passport to the Google apps universe. It gives you a way to sign in just once and access all of Google’s goodies. It’s also where you add new programs, change your name or password, and do other across-the-board management. And here’s the best part: A Google Account is free. As in totally, completely, won’t-cost-you-a-dime free.

If you’ve created an account for any Google offering—like Gmail, Google Docs, or Google Calendar—you’ve already got a Google Account. So you can skip the section on signing up and turn to page 9 to learn more about what you can do with your account.

On the other hand, maybe you’ve made it well into the 21st Century without a Google Account, thank you very much. If that’s the case, your time has come: You need an account to use Gmail, Google Docs, Google Calendar, and many other Google tools. In addition, when you’re signed into your Google Account, you can customize your apps, check out recommendations made just for you, and get even better search results. This chapter shows you how to get started.

NOTE
The bulk of this chapter addresses the boring but necessary sign-up procedures required to uncork the Google apps magic. If you’ve already got a Google Account, or consider account sign-up guidance a crutch needed only by lesser mortals, feel free to skip ahead to Chapter 2, where the heart of the Google apps coverage begins.

Signing Up for a Google Account

It takes only a couple of minutes—you can pop a celebratory pizza in the microwave and be done before the timer dings. Then, as you munch on a slice or two, you just have to pick which programs you want to use, and add a bit of personal info.
NOTE

If you use Google Apps through your organization—for example, if you sign into Gmail with a user name that looks like myname@mycompany.com—you don’t need to create a separate Google Account. Your organization creates and manages your apps through its own Web site. (See Chapter 10 for more information about Google Apps for organizations.)

Start by going to Google’s home page (http://www.google.com) and, in the upper-right corner, click the link that says, “Sign in”. Alternatively, you can go straight to the Google Accounts sign-in page at http://www.google.com/accounts.

Whichever route you take, the Google Accounts sign-in page looks like Figure 1-1. After you’ve opened your account, you’ll see this page again whenever you want to sign in and use your Google services. For now, though, click the right-hand “Create an account now” link, and you’re taken to the page shown in Figure 1-2.

![Google Accounts sign-in page](http://www.google.com/accounts)

**Figure 1-1.** Clicking the “Sign in” link on Google’s home page takes you here. The left-hand side of the page tempts you with various programs you can use once you sign up. The right-hand side is where you’ll sign into the Google Account you’re about to create. To get started, click “Create an account now” (circled).
If you have questions about Google Accounts before (or even after) you sign up, more help awaits at www.google.com/support/accounts (http://www.google.com/support/accounts).

Google’s sign-up form is simple; you can fill it out and start using your new Google Account in mere seconds. Here’s what’s on it:

- **Your current email address.** Type in the email address you use right now, like johndoe@yahoo.com or janemesmith@mycompany.com. (After you’ve read Chapter 5, you’ll probably want to switch to Gmail, but you can open a Google Account using any working email address.)
• **Choose a password.** Your Google Account password has to be at least eight characters long and can contain letters, numbers, and symbols. See the box below for tips on creating a good password.

• **Re-enter password.** Nothing is more annoying than locking yourself out because you entered a typo when creating your password—and now you have no clue what the password is. To make sure that doesn’t happen, retype your password here (don’t copy and paste it from the box above—that’ll just duplicate any typos).

---

**WORD TO THE WISE**

**Password Primer**

Since your Google Account is the central sign-in for all your Google apps (meaning you use the same user name and password for everything), you want to make sure that your password is extra secure so no one can get into your email, calendar, and personal documents in one fell swoop. So put a bit of thought into selecting your password. Here are some ways to make your password tough to crack:

• **Go for a little variety.** You probably already have a bunch of different passwords for a bunch of different purposes: email, online shopping, sites like Facebook, and so on. Instead of recycling one of those passwords, create a brand-new one just for your Google Account. That way, if somebody learns your Facebook password, for example, your Google Account is still secure.

• **Avoid the obvious.** Don’t make your user name (page 10) double as your password. Similarly, don’t use googleapps, googleaccount, or password as your password. Those words might be easy for you to remember, but they’re just as easy for someone else to guess.

• **Think outside the dictionary.** Don’t use a word that appears in the dictionary (English or any other language). Instead, use a combination of letters, numbers, and symbols. One way to create a password that’s easy for you to remember but hard for someone else to guess is to substitute numbers or symbols for letters they resemble. For example, instead of stanford, try st@nf0rd. And, for heaven’s sake, don’t use the word “password” in any form.

• **Combine upper- and lowercase letters.** When it comes to your password, Google distinguishes between capital letters and lowercase ones. Use this to your advantage: go with LuCKyGiRL instead of luckygirl.

• **Go big.** Google requires that your password be at least eight characters long—and that’s a good start. The longer a password is, the harder it is to guess. So add a few more characters beyond the minimum eight to make your password even more secure.
• **Remember me on this computer.** If you’re setting up your account on a computer nobody else uses, turn on this checkbox to save a little sign-in time. Google responds by automatically filling in your login info every time you visit the sign-in screen. But if you’re on a shared computer (at a public library, for example), leave this box turned off so no one else can get into your account.

• **Enable Web History.** When you’re signed in to your Google Account, Web History keeps track of your searches as you wander around the Web. When you sign up, Google turns it on by default, and that means you can take a look back at sites you’ve visited, search them, and get personalized Search results based on your history. Since you can access your Web History from any computer with an Internet connection, it’s like having a permanently handy record of all the searches you’ve ever done. The box on page 8 has more about Web History to help you decide whether you want it in your Google Account.

• **Location.** From the drop-down list, choose your country.

• **Word verification.** You may have seen similar combinations of wavy, skewed letters (and sometimes numbers) on other Web pages. Word verification makes sure you’re a real, live person, not an automated “bot” that crawls the Web and signs up for accounts to use for spamming and other nefarious purposes. Take a look at those wavy letters, filter them through your human brain, and type them into the box (capitalization doesn’t matter).

• **Terms of Service.** You’ve got to agree to Google’s terms of service if you want to open an account. Give them a quick read, or check out the box on page 38 for the highlights.

When you’ve filled everything out, give the page a quick once-over to make sure it all looks good. Then click “I accept. Create my account.” Google sends you a verification email like the one in Figure 1-3. Click the link in the email and your account is up and running. (If clicking the link doesn’t do anything, copy the link and paste it into your browser’s address bar.) Your browser opens a page that says Google has verified your account. From here, click the link to go to your brand-new Google Account.

---

**NOTE**

Don’t reply to the verification email. If you do, your email will get lost in cyberspace, since nobody at Google looks at or replies to these verification emails. Instead, look for answers at the Google Accounts Help page: www.google.com/support/accounts (http://www.google.com/support/accounts). Better yet, keep reading this book.
uploading presentations from, 189
vs. Web sites, 449
Web Pages (Google Apps)
vs. Page Creator, 575
Web-based applications, xiv–xvii
Week view (Google Calendar), 363
weekends, hiding/showing (Google Calendar), 377
weight, outline (shapes), 210
whitelists, 561
WHOIS directory, 492
widgets (see gadgets)
widths
of calendars, setting, 386, 608
of tables, setting, 67
wikis, 593
Windows Control Panel, uninstalling Google Toolbar from, 37
Windows System Tray, 313
launching Google Talk from, 315
signing out of Google Talk from, 331
Windows Vista, Google Talk client and, 568
WinZip, 241
Word (.doc) files, saving documents as, 46
word verification, 7
word-processing documents (see documents)
workspace, Gmail, 231
wrapping text
around images, 606
in documents, 63
in spreadsheets, 122
on Google Sites, 612
Writerly documents, opening in Docs, 49
writing messages (Gmail), 249

X
x-axis (charts), 157
XHTML, Google Calendar and, 401
XML, iGoogle themes and, 416
XY charts, 156

Y
y-axis (charts), 157
Yahoo Calendar, 396
Your Sites page (Google Sites), 598, 644
YouTube, xx, 613
gadgets, 432
videos in presentations, 210

Z
Zip files, attached (Gmail), 241
ZipIt, 241